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KEELOQ® 3 DEVELOPMENT KIT
USER’S GUIDE
Preface
INTRODUCTION 

This chapter contains general information that will be useful to know before using the 
KEELOQ® 3 Development Kit User’s Guide. Items discussed in this chapter include:

• Document Layout

• Conventions Used in this Guide

• Warranty Registration

• Recommended Reading

• The Microchip Web Site

• Development Systems Customer Change Notification Service

• Customer Support

• Document Revision History

DOCUMENT LAYOUT 

This document describes how to use the KEELOQ® 3 Development Kit User’s Guide as 
a development tool to emulate and debug firmware on a target board. The manual lay-
out is as follows: 

• Chapter 1. “KeeLoq® 3 Development Kit Overview”

• Chapter 2. “Getting Started”

• Chapter 3. “Using the KEELOQ® 3 Development Kit MPLAB Plug-In”

• Chapter 4. “Using the I2C™ GUI Interface Demo Tool”

• Chapter 5. “KEELOQ® 3 Development Kit Controller”

• Chapter 6. “KEELOQ® 3 Development Kit Controller Firmware”

• Chapter 7. “KEELOQ® 3 Development Kit PIC16F636 Transmitter”

• Chapter 8. “KEELOQ® Transceiver Add-On Kit”

• Chapter 9. “Troubleshooting”

• Appendix A. “KEELOQ® 3 Development Kit Schematics”

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our web site 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 
document.

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help. 
Select the Help menu, and then Topics to open a list of available online help files.
 2011 Microchip Technology Inc. DS41378B-page 5
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• Appendix B. “MRF49XA Schematics”

CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}

DS41378B-page 6  2011 Microchip Technology Inc.



Preface
WARRANTY REGISTRATION

Please complete the enclosed Warranty Registration Card and mail it promptly. 
Sending in the Warranty Registration Card entitles users to receive new product 
updates. Interim software releases are available at the Microchip web site.

RECOMMENDED READING

This user’s guide describes how to use KEELOQ® 3 Development Kit User’s Guide. 
Other useful documents are listed below. The following Microchip documents are avail-
able and recommended as supplemental reference resources.

Readme for KEELOQ® 3 Development Kit User’s Guide

For the latest information on using the KEELOQ® Development Kit please go to 
www.microchip.com/keeloq.

Readme Files

For the latest information on using other tools, read the tool-specific Readme files in 
the Readmes subdirectory of the MPLAB IDE installation directory. The Readme files 
contain update information and known issues that may not be included in this user’s 
guide.
 2011 Microchip Technology Inc. DS41378B-page 7
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THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web 
site is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the web site contains the following 
information:

• Product Support – Data sheets and errata, application notes and sample 
programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip 
products. Subscribers will receive e-mail notification whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of 
interest.

To register, access the Microchip web site at www.microchip.com, click on Customer 
Change Notification and follow the registration instructions.

The Development Systems product group categories are:

• Compilers – The latest information on Microchip C compilers and other language 
tools. These include the HI-TECH C®, MPLAB C18 and MPLAB C30 C compilers; 
MPASM™ and MPLAB ASM30 assemblers; MPLINK™ and MPLAB LINK30 
object linkers; and MPLIB™ and MPLAB LIB30 object librarians.

• Emulators – The latest information on Microchip in-circuit emulators.

• In-Circuit Debuggers – The latest information on the Microchip in-circuit 
debuggers.

• MPLAB® IDE – The latest information on Microchip MPLAB IDE, the Windows® 
Integrated Development Environment for development systems tools. This list is 
focused on the MPLAB IDE, MPLAB SIM simulator, MPLAB IDE Project Manager 
and general editing and debugging features.

• Programmers – The latest information on Microchip programmers.
DS41378B-page 8  2011 Microchip Technology Inc.



Preface
CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support.microchip.com

DOCUMENT REVISION HISTORY

Revision A (March 2009)

• Initial Release of this Document.

Revision B (January 2011)

The following have been added:

• Chapter 8. “KEELOQ® Transceiver Add-On Kit”

• Appendix B. “MRF49XA Schematics”
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KEELOQ® 3 DEVELOPMENT KIT

USER’S GUIDE

Chapter 1.  KEELOQ® 3 Development Kit Overview
1.1 INTRODUCTION

The KEELOQ® 3 Development Kit consists of a controller board, a radio receiver board 
and two handheld transmitters.

The controller board uses a modular approach so it can be used in various 
configurations. The board features a 14-pin PICtail™ connector to accommodate a 
radio receiver board and a 28-pin PICtail connector for expansion. The PIC16F886 
microcontroller on the controller board can be programmed in circuit using the onboard 
PICkit connector. Also, it can be connected to the PICkit Serial Analyzer for serial 
communication with a PC.

One receiver board containing the Microchip rfRXD0420 ASK radio receiver chip is 
included in the kit.

Two hand-held transmitters are included with the KEELOQ 3 Development Kit. One uses 
a standard HCS362 hardware encoder and the other uses a PIC16F636 
microcontroller.

To assist in KEELOQ encoder/decoder development and programming, an MPLAB 
KEELOQ plug-in is also supplied. A separate graphical user interface (GUI) is supplied 
to demonstrate I2C communication using the PICkit serial analyzer connection.

In addition to the traditional KEELOQ encryption/decryption routines, KEELOQ/AES and 
KEELOQ/XTEA encryption/decryption routines are available by ordering the CD 
“Advanced Security Algorithms for KEELOQ® Systems” (microchipDIRECT 
#SW163052).

A separate transceiver Add-On Kit (AC303007) is available through Microchip. This 
Add-On kit uses the MRF49XA transceiver and the PIC16F636 microcontroller as a 
two-way encrypted communication solution. Please see Chapter 8. “KEELOQ® 
Transceiver Add-On Kit” for more details on the operation and characteristics of this 
Add-On kit.

1.2 HIGHLIGHTS 

This chapter discusses:

• KEELOQ 3 Development kit contents

• KEELOQ 3 Development kit Hardware

• KEELOQ 3 Development kit Software

1.3 KEELOQ 3 DEVELOPMENT KIT CONTENTS

The KEELOQ 3 Development Kit contains the following items:

• KEELOQ 3 controller board 

• PIC16F636 KEELOQ transmitter 

• HCS362 KEELOQ transmitter 

• 433.92 MHz ASK receiver board 

• Documentation and software CD-ROM

• Optional PICkit Programmer/Debugger
 2011 Microchip Technology Inc.  DS41378B-page 11
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• Optional USB cable

• Optional PICkit Serial Analyzer

1.4 KEELOQ DEVELOPMENT SYSTEMS 

The KEELOQ 3 Development Kit is a hardware platform that can be used to evaluate 
various KEELOQ-based encryption/decryption solutions. Once the user gets familiar 
with the operation of the kit, the software can be modified to suit the user’s needs. The 
kit itself is based on a modular approach so it can be used in many configurations 
without being restricted to a specific application. 

1.5 KEELOQ 3 DEVELOPMENT KIT HARDWARE 

1.5.1 Controller Board

Figure 1-1: KEELOQ® 3 DEVELOPMENT KIT

The controller board is meant to be a decoding portion of a complete security system, 
such as a car security system, garage door or any other application requiring data 
encryption.

The controller is also the radio receiver and decoder of the KEELOQ Kit. The received 
data is decrypted and checked against a known transmitter (if it was previously learned 
by the controller), then the Transmitter function is signaled to the user. 

1. Standard 9-volt power connector
2. PICkit™ 2 programming header
3. PICkit Serial header
4. Radio receiver connector (PICtail™ compatible)
5. Generous prototyping area
6. LEDs
7. Push-Buttons (3 buttons)
8. LCD display (2*16 characters)
9. PIC16F886
10. PICtail™ 28-pin connector
DS41378B-page 12   2011 Microchip Technology Inc.
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The controller features various connectivity elements. The supplied receiver card 
features a Microchip rfRXD0420 ASK radio receiver chip used in the 433.92 MHz ISM 
band. Because the receiver is a separate card with a PICtail™ connector ([4] in 
Figure 1-1), the user can replace the receiver card with any custom radio receiver unit.

The heart of the controller board is the Microchip PIC16F886 microcontroller ([9] in 
Figure 1-1). The controller features a PICkit compatible connector header ([2] in 
Figure 1-1) that allows in-circuit programming using the PICkit microcontroller 
programmer/debugger. Any other Microchip programmer/debugger tool can be used, 
provided that:

• The programmer/debugger supports the PIC16F886 (please check for the latest 
firmware update for the programmer).

• Some in-circuit debuggers use an RJ-11 connector. You will need an RJ-11 to 
ICSP™ adapter (Microchip part number AC164110).

To demonstrate serial communication, the board can be connected to the Microchip 
PICkit Serial Analyzer module through the PICkit serial header ([3] in Figure 1-1). The 
controller firmware is configured to support I2C slave communication (the PICkit serial 
module should be configured as the master).

Also, for user interaction with the board, the following elements are present on the 
board:

• an LCD display (2* 16 characters) ([8] in Figure 1-1)

• 3 push buttons ([7] in Figure 1-1) 

• 4 LEDs ([6] in Figure 1-1)

The control board can be powered in one of the following ways:

• Using a 9-volt adapter connected to the board’s power socket ([1] in Figure 1-1)

• PICkit supplied power

• PICkit Serial Analyzer supplied power

1.5.2 Receiver Board

The receiver board features the Microchip rfRXD0420, low-cost, high-performance 
ASK receiver IC. The module is suitable for:

• Wireless remote command and control

• Remote Keyless Entry (RKE)

• Security Systems

• Low-power telemetry applications

The module characteristics are:

• Single channel, fixed frequency of 433.92 MHz

• ASK modulation

• Baud rate: 4800bps

For more information on the rfRXD0420 receiver module, please refer to the technical 
brief TB070.
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FIGURE 1-2: RFRXD0420 RECEIVER BOARD

1.5.3 Transmitter Boards

FIGURE 1-3: TRANSMITTER BOARD

The kit contains two hand-held transmitter boards:

• HCS362 KEELOQ hardware encoder

• PIC16F636 microcontroller software encoder

These transmitters allow the user to explore a wider range of hardware configurations. 
Additionally, both transmitters can be modified to add DIP sockets, enabling the user to 
change the encoder device easily.

The RF transmitters use a simple Colpitts oscillator driven by a SAW (Surface Acoustic 
Wave) resonator. Both transmitters are powered by a CR2032 or equivalent 3V battery 
(not included in the kit).
DS41378B-page 14   2011 Microchip Technology Inc.
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1.6 KEELOQ 3 DEVELOPMENT KIT SOFTWARE 

1.6.1 The MPLAB® Plug-In

The KEELOQ 3 Development Kit MPLAB plug-in is a tool that integrates into the MPLAB 
Integrated Development Environment. It helps with setting and programming the 
transmitter encoders. The MPLAB plug-in supports KEELOQ/XTEA/AES key 
generation. To enable the XTEA/AES options please order the CD “Advanced Security 
Algorithms for KEELOQ® Systems” (DS51813).

More detailed information can be found in Chapter 3. “Using the KEELOQ® 3 
Development Kit MPLAB Plug-In”.

1.6.2 Controller I2C™ Graphical User Interface 

The controller firmware supports a set of I2C commands. These commands are used 
to control and interact with the Controller Board Decoding functions.

The I2C GUI uses the PICkit Serial Analyzer connected to the controller to 
communicate and display the results on the PC. More details can be found in Chapter 
4. “Using the I2C™ GUI Interface Demo Tool”.
 2011 Microchip Technology Inc.  DS41378B-page 15
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Chapter 2.  Getting Started
2.7 INTRODUCTION 

This chapter will get you started using the KEELOQ® 3 Development Kit and the 
attached software.

2.8 HIGHLIGHTS 

This chapter discusses:

• Setting up the KEELOQ 3 Development Kit hardware

• Installing the KEELOQ 3 Development Kit software

• Starting the KEELOQ 3 Development Kit software 

• Basic I2C communication

• Source code

2.9 SETTING UP THE KEELOQ 3 DEVELOPMENT KIT HARDWARE

Plug the radio board into the PICtail 14 pin connector as shown in Figure 2-4 below:

FIGURE 2-4: PICtail™ 14-PIN ASK CONNECTION

Connect the controller to a 9V DC power supply.
 2011 Microchip Technology Inc.  DS41378B-page 17
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Once powered up, the controller LED-D1 will flash five times and the welcome screen 
will appear on the LCD screen:

“KEELOQ 3 Development Kit”

FIGURE 2-5: LCD SCREEN – WELCOME MESSAGE

2.9.1 Using the Transmitter Boards

Install a 3V CR2032 or equivalent battery on the PIC16F636 transmitter board. Press 
any button on the transmitter board. LED-D4 will flash and the serial number and the 
decoded transmitted information will appear on the LCD display.
DS41378B-page 18   2011 Microchip Technology Inc.
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FIGURE 2-6: LCD SCREEN WITH DECODED INFORMATION

2.9.2 How the Controller Board Learns a Transmitter

• Press button PB3 on the controller board. LED-D4 will remain on indicating the 
controller has entered Learn mode. 

• Press a button on the transmitter once, the LED will blink indicating that the con-
troller is waiting for a second press. 

• Press the transmitter button a second time. LED-D4 will flash rapidly followed by 
LED-D3. 

• Now, whenever the transmitter button is pressed, LED-D4 will flash, followed by 
LED-D3 indicating that the transmitter is a valid learned transmitter.

2.9.3 How the Controller Board Erases Stored Transmitter 
Information

• Press button PB3 on the controller board. LED-D4 will remain on.

• Keep button pressed for about 10 seconds. LED-D4 will turn off.

• Release PB3, all stored transmitter information is now erased. When a transmitter 
button is pressed, LED-D4 will now flash rapidly.

2.10 INSTALLING THE KEELOQ 3 DEVELOPMENT KIT SOFTWARE 

2.10.1 Installing the MPLAB Plug-In

From the CD, run MPLAB_PlugIn > MPLAB_PlugInSetup.exe.

The installer software installs everything automatically. Once the installer software 
begins you must accept the Microchip License Agreement in order to proceed with the 
installation process.

More details can be found in Chapter 3. “Using the KEELOQ® 3 Development Kit 
MPLAB Plug-In”.
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2.10.2 Installing the I2C GUI Sample Program

From the CD, run I2C_GUI > I2C_GUI_Setup.exe.

The installer software installs everything automatically. There is no KEELOQ related 
license agreement for the I2C Graphical User Interface. However, the software is 
covered by Microchip’s general license terms.

More details about the installation process can be found in Section 4.24 “Overview: 
Installing the I2C Graphical User Interface”.

2.11 STARTING THE MPLAB PLUG-IN

To start the plug-in:

Launch MPLAB® IDE (navigate to Start > All Programs > Microchip > MPLAB IDE v8.xx 
> MPLAB IDE ).

In MPLAB IDE, under the Tools menu, click on KEELOQ 3 Development Kit.

2.12 STARTING THE I2C GUI DEMONSTRATION PROGRAM 

You can start the KEELOQ 3 Development Kit I2C Graphical User Interface by navigating 
to Start > All Programs > Microchip > KEELOQ 3 Development Kit > click on I2C GUI. 
For detailed information, see Chapter 4. “Using the I2C™ GUI Interface Demo 
Tool”.

2.13 DEMO I2C™ SOURCE CODE AND FIRMWARE

The source code is installed automatically by the I2C Graphical User Interface 
installation program. 

To start the KEELOQ 3 Development Kit I2C Graphical User Interface, navigate to Start 
> All Programs > Microchip > KEELOQ 3 Development Kit > click on I2C GUI VB 
workspace.
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Chapter 3.  Using the KEELOQ® 3 Development Kit
MPLAB Plug-In

3.14 INTRODUCTION
The KEELOQ® 3 Development Kit MPLAB® Plug-in is a tool that integrates into the 
MPLAB Integrated Development Environment.

The KEELOQ MPLAB Plug-in automatically calculates the necessary codes needed for 
a KEELOQ encoder. These include the encryption key, configuration parameters, seed, 
and serial number.

The KEELOQ MPLAB Plug-in features a code calculator that allows the user to KEELOQ 
encrypt and/or decrypt a code for debugging purposes. 

It also allows encoder programming directly from the MPLAB IDE. 

3.15 HIGHLIGHTS 

This chapter discusses:

• Installing the KEELOQ 3 Development Kit Plug-in

• Starting the plug-in

• Selecting a device

• Programming the HCS362 based transmitter

• Programming a PIC16F636 based transmitter

• KEELOQ tool

3.16 INSTALLING THE KEELOQ 3 DEVELOPMENT KIT PLUG-IN 

Insert the KEELOQ 3 Development Kit CD-ROM into the CD-ROM drive. Browse the 
CD-ROM directory and find the Setup.exe file located in the MPLAB KEELOQ Plug-in 
directory.

Follow the directions on the screen to install the KEELOQ 3 Development Kit Plug-in.

MPLAB-IDE must be already installed. 

3.17 STARTING THE PROGRAM 

You can start the plug-in by starting the MPLAB IDE (navigate to Start > All Programs 
> Microchip > MPLAB IDE v8.xx > MPLAB IDE) 

In MPLAB IDE, under the Tools menu, click on KEELOQ 3 Development Kit.

The plug-in can be used with or without having a currently loaded project (workspace).

3.18 SELECTING A DEVICE 

In the MPLAB KEELOQ plug-in there is a selection tree in the left side.

Click on an item in the left side tree. The right side of the Main window changes 
according to the current selected item.
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3.19 PROGRAMMING THE HCS362 TRANSMITTER.

The MPLAB KEELOQ 3 Development Kit Plug-in supports direct programming of the 
HCS362 transmitter using one of the following programmers:

• PICkit microcontroller programmer 

• PM3 universal programmer.

To select a programmer:

• Under the KEELOQ menu, go to Programmer menu

• Select one of the supported programmers

To enter the manufacturer code:

• In the two lower side boxes, enter the manufacturer codes needed to calculate 
both encryption keys

Please note that once the manufacturer code is entered, it is internally stored but it will 
not be displayed – the manufacturer code edit box will show “xxxxxxxxxxxxxxxx”.

Programming all the encoder options is done by means of the selection boxes and 
check boxes (as shown in Figure 3-7).

The HCS362 transmitter only supports traditional KEELOQ encryption.

Note: The programming section of the MPLAB KEELOQ plug-in is independent of 
the MPLAB programming section. When programming a hardware KEELOQ 
encoder (such as the HCS series) there is no need to change the current 
selected device in the main MPLAB window. However, there is a limitation 
that one programmer cannot be selected as active programmer for both the 
KEELOQ plug-in and the MPLAB current programmer. If using the same 
programmer, you can deselect it in the MPLAB main window and use it with 
the KEELOQ plug-in. Different programmers can be used at the same time.
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FIGURE 3-7: HCS362 OPTIONS WINDOW

All the encoder configuration options are explained in the following table:

TABLE 3-1: ENCODER CONFIGURATION OPTIONS

Configuration Option Description 

Key Generation Select the Key generation algorithm.

User Serial Number Enter a 28/32-bit hex value.
If the Extended Serial Number option is not selected, only the 28 LSbs will be transmitted. 

Auto Increment This will cause the serial number field to increment if an encoder is programmed 
successfully. 

28-bit or 32-bit If 32-bit is selected, the full 32-bit serial number is transmitted. If 28-bit is selected, the top 
serial number nibble is replaced with the function code. 

Modulation Format There are two modulation formats: PWM and Manchester. 

Baud Rate TE value used during transmissions. Select Baud Rate: 100 μs, 200 μs, 400 μs or 800 μs. 

Minimum Code Words Used to select the minimum number of code words transmitted when the device is 
activated. 

Guard Time The longest guard time or time between transmissions can be used to lower the average 
power transmitted during a period of time to help meet regulatory requirements. 

Overflow Bits Select the overflow cycles for the synchronous counters. 

Low Voltage Select Selects the voltage at which the VLOW flag (bit) is set in a transmission. 

Time-out If enabled, the device will shut off after transmitting continuously for a predetermined time. 
This prevents a complete battery discharge if an input transmitter button is stuck in the ON 
position. 

Xmit CRC/Time Bits You can select the desired functionality of these two Status bits. Selecting CRC will enable 
a two-bit Cyclic Redundancy Check code used by the decoder to verify the integrity of a 
code word. Selecting Time bits will send different bit patterns at different points in time 
when pressing and holding a button. This permits multiple functions obtained from the 
same function code. 
 2011 Microchip Technology Inc.  DS41378B-page 23



KEELOQ® 3 Development Kit User’s Guide
3.19.1 Programming the Part

Click on the Program button in the toolbar: 

Programming progress is displayed in the MPLAB Output window.

After a successful programming, if the option is enabled, the serial code is incremented 
and a new programming sequence can start.

3.20 PROGRAMMING THE PIC16F636 TRANSMITTER

The PIC16F636 transmitter is a microcontroller-based solution, allowing the firmware 
to be adapted for a particular need. The PIC16F636 KEELOQ Software encoder 
KEELOQ/XTEA, KEELOQ/AES source codes are provided by Microchip under the 
KEELOQ encoder license agreement.

All the encoder configuration data, encryption keys, seeds, and serial numbers are 
stored into the EEPROM of the PIC16F636.

The MPLAB KEELOQ plug-in cannot directly program the microcontroller in the same 
way as programming a hardware encoder. Instead, the KEELOQ software encoder 
source code must be loaded into MPLAB. The MPLAB KEELOQ plug-in can export the 
memory map for the current encoder options to the EEPROM memory. Programming 
is done in the usual way, as when programming a microcontroller.

LED Operation Two different LED flashing rates are available which correspond to different low battery 
indication modes. 

Sync. Counter Enter a 16-bit hex value (0 through FFFF). 
This is the initial value of the synchronization counter. 

Discrimination Value You can opt for the default setting equal to the 10 LSbs of the serial number or enter an 
arbitrary 10-bit value (0 through 3FF). 

SEED Enable Select between four modes of operation: 
No Seed – disables the Seed transmission feature
Limited Seed – disables Seed transmission when the synchronization counter reaches 80 
hex (128)
Permanent and Delayed Seed – Seed transmissions are permanently enabled and 
delayed
Permanent Seed only – disables the Delayed Seed Transmission function codes

SEED The Seed is a 60-bit value that can be either random (recommended for Secure Learn 
methods) or an arbitrary 60-bit value. It will be transmitted in place of the hopping code 
and fixed code portions of the code word when the predetermined Seed function code 
(button) is activated. 

SEED Button Options This field determines what function code will produce an immediate or delayed Seed 
transmission. 

3 TE Header This option allows you to shorten the synchronization header to 3xTE. Otherwise, the 
default value is 10xTE

RF Enable If enabled, this option produces a high output on the S3 pin before data is transmitted 
through the DATA pin. The S3 pin will still be available as a button input, but its 
de-bouncing and repeat timing functionality will be affected. 

TABLE 3-1: ENCODER CONFIGURATION OPTIONS
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.

TABLE 3-2: PIC16F636 TRANSMITTER CONFIGURATION TRADITIONAL KEELOQ OPTIONS

Configuration Option Description 

Encryption Key Selects key generation algorithm. 

Serial Number Enter a 28-bit or a 32-bit hex value depending on the 28 or 32-bit selection below the serial 
number box.

Auto Increment This will cause the serial number field to increment if an encoder is programmed 
successfully. 

28-bit or 32-bit radio 
buttons

If 32-bit is selected, 32-bit serial numbers can be used. If 28-bit is selected, only 28-bit 
serial numbers can be used. Also, if the current serial number has more than 28 bits, it is 
automatically adjusted to 28 bits.

Modulation Format There are four modulation formats: PWM, Manchester, VPWM, and PPM. 

Baud Rate TE value used during transmissions. There are four baud rates: 100 μs, 200 μs, 400 μs, 
and 800 μs. 

Header Length Select the header time frame as either 4xTE or 10xTE. 

Guard Time Extending the guard time can be used to lower the average power transmitted during a 
period of time; to help meet regulatory requirements. 

Low Voltage LED Blink If set to Once, the transmitter’s LED blinks only once if a low battery condition is detected. 

LED On Time Allows selection of the LED blink timing. 

Overflow Bits Select the overflow cycles for the synchronous counters. 

SEED The Seed is a 60-bit value that can be either random (recommended for Secure Learn 
methods) or an arbitrary 60-bit value. It will be transmitted in place of the hopping code and 
fixed code portions of the code word when the predetermined Seed function code (button) 
is activated. 

SEED Button This field determines what function code will produce an immediate or delayed Seed 
transmission. 

SEED Trigger This field determines what function code will produce an immediate or delayed Seed 
transmission. 

Time before SEED Determines if and when a delayed Seed transmission will be activated by the Seed Button 
function code. 

Production SEED If enabled, the Seed mode is set to Production mode. If disabled, it is set to User mode. 

Limited SEED If enabled, disables the Seed transmission when the synchronization counter reaches 80 
hex (128). 

Sync Counter Depending on the Counter Select option enter a 16-bit of a 20-bit sync counter. This is the 
starting point of the sync counter.

Discrimination Value You can opt for the default setting equal to the 10 LSbs of the serial number or enter an 
arbitrary 10-bit value (0 through 3FF).

Start/Stop Pulse Enable If enabled, this option adds a Start bit (1) to the code word after the synchronization header 
and a Stop bit (1) after the last Status bit (end of the code word). 

Queue Counter Enable Activates the Queue status bits functionality. This allows an application to distinguish 
between single, double, triple and quadruple button presses. 

Time-Out If enabled, the device will shut off after transmitting continuously for a predetermined time. 
This prevents a complete battery discharge if an accidental input. 

Low Voltage Select Selects the voltage at which the VLOW flag (bit) is set in a transmission. 

Wake-Up Select Selects the length and duty cycle of an optional extra Wake-Up preamble, transmitted 
before the first code word. 

PLL Interface Select Choose between ASK and FSK for the PLL Interface. 

Minimum Code Words Used to select the minimum number of code words transmitted when the device is 
activated. 
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For the PIC16F636 software encoder, the KEELOQ plug-in uses the following memory 
map:

Counter Select Selects the Synchronization Counter size to be the standard 16-bit or extended to 20-bit. 

Dual Encoder Enable* Makes the S3 pin act as a SHIFT input to select between (sub) encoder #1 and #2 
activation. 

Low Voltage Latch If enabled, Low battery indication is latched on the first occurrence and remains so until the 
battery is changed (i.e., power cycled). 

RF Enable If enabled, this option will produce a high output on the S3 pin to use as an Enable signal 
for ASK PLL transmitter circuits. The S3 pin will still be available as a button input, but its 
de-bouncing and repeat timing functionality will be affected; its use cannot be 
recommended for frequent function codes use. 

TABLE 3-2: PIC16F636 TRANSMITTER CONFIGURATION TRADITIONAL KEELOQ OPTIONS

TABLE 3-3: MEMORY MAP

Memory location Description Encoder

0x00 = A
0x01 = B
0x02 = C

Sync counter. MSB first.  
Encoder 1

0x03 = B XOR C
0x04 = A XOR B
0x05 = A XOR C

Checksums for sync counter.

0x08 = A
0x09 = B
0x0A= C

Sync counter. MSB first.
Encoder 2

0x0B = B XOR C
0x0C = A XOR B
0x0D = A XOR C

Checksums for sync counter.

0x10 0x11 0x12 0x13 32-bit serial number. MSB first.

Encoder 10x14 0x15 0x16 0x17 
0x18 0x19 0x1A 0x1B

4-bit seed code + 60-bit seed. MSB first

0x1C : ---- --10 Discrimination value first 2 MSB
: ---- 32-- Transmission Modulation Format
: ---4 ---- Header Select 
: --5- ---- Extended Serial Number 
: -6-- ---- Queue counter
: 7--- ---- Start/Stop Pulse Enable

0x1D Discrimination value 8 LSB

0x1E 0x1F 0x20 0x21
0x22 0x23 0x24 0x25

64-bit encryption key. MSB first
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Once you have selected all the required options you can export the memory map to the 
EEPROM memory by pressing the EEPROM Export button.

0x26 0x27 0x28 0x29 32-bit serial number. MSB first.
Encoder 2

0x2A 0x2B 0x2C 0x2D
0x2E 0x2F 0x30 0x31 4-bit seed code + 60-bit seed. MSB first

0x32 : ---- --10 Discrimination value first 2 MSB
: ---- 32-- Transmission Modulation Format
: ---4 ---- Header Select 
: --5- ---- Extended Serial Number 
: -6-- ---- Queue counter

0x33 Discrimination value 8 LSB
0x34 0x35 0x36 0x37
0x38 0x39 0x3A 0x3B

64-bit encryption key. MSB first

0x3C : ---- ---0 Limited Seed 
: ---- --1- Seed Mode 
: ---- 32-- Time Before Seed Code
: --54 ---- Transmission Baud Rate
: 76-- ---- Guard Time Select

Encoder 1

0x3D Device Options:
: ---- --10     Minimum Code Words Value
:----   -2--     Dual Encoder 
: ----  3---     RF Enable Output Select 
: --54 ----     Time-out Select Value2 Time(s) 2.0
: -6-- ---- Low Voltage LED Blink (Encoder 2)
: 7--- ---- LED On Time Select (Encoder 2)

Device options

0x3E : ---- ---0  Limited Seed 
: ---- --1-  Seed Mode 
: ---- 32-- Time Before Seed Code
: --54 ---- Transmission Baud Rate
: 76-- ---- Guard Time Select

Encoder 2

0x3F Device options: 
: ---- --10 Wake-up
: ---- -2-- Counter Select 
: ---- 3--- Low Voltage Latch Enable 
: ---4 ---- Low Voltage Trip Point Select
: --5- ---- PLL Interface Select  
: -6-- ---- Low Voltage LED Blink (Encoder 1)
: 7--- ---- LED On Time Select (Encoder 1)

Device options

TABLE 3-3: MEMORY MAP (CONTINUED)
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3.21 MEMORY MAP FOR XTEA/AES

The full version of the plug-in has the capability of programmig the memory maps for a 
KEELOQ/XTEA and KEELOQ/AES transmitter. The full version plug-in advanced trans-
mitter application notes are contained in the CD “Advanced Security Algorithms for 
KEELOQ Systems” (microchipDIRECT #SW163052).

FIGURE 3-8: KEELOQ® CODE CALCULATOR

The KEELOQ code calculator is a tool that can encrypt and/or decrypt a 32-bit value, 
based on a 64-bit encryption key. 

The encryption key can be also calculated based on several key generation algorithms; 
a manufacturer code, a serial number and/or a seed value. For key generation 
algorithms that are based on a seed value, there are three buttons to select between 
32, 48 or 60-bit seed value. Depending on the seed length, the key generation 
algorithm changes accordingly. 
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Chapter 4.  Using the I2C™ GUI Interface Demo Tool
4.22 INTRODUCTION 

The I2C™ Graphical User Interface is a PC software tool used to communicate with the 
Controller board.

The connection with the KEELOQ® 3 Development Kit Controller is done with a PICkit 
Serial Analyzer module. The Controller board features a PICkit Serial compatible, 6-pin 
header for direct connection to the PICkit Serial Analyzer.

FIGURE 4-9: PICkit™ SERIAL ANALYZER CONNECTION

4.23 HIGHLIGHTS 

This chapter discusses:

• the I2C Graphical User Interface (GUI)

• how to use the I2C Graphical User Interface

4.24 OVERVIEW: INSTALLING THE I2C GRAPHICAL USER INTERFACE

Insert the KEELOQ 3 Development Kit CD-ROM into the CD-ROM drive. Browse the 
CD-ROM directory and find the Setup.exe file located in the I2C GUI folder.

Follow the direction on the screen to install the I2C Graphical User Interface.

Note: A PICkit™ Serial Analyzer P/N DV164122 (sold separately) is required to 
perform the functions specified in this chapter.
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MPLAB IDE is not required to run this software.

4.25 INTERFACE WINDOW

Below is a screenshot of the GUI window (Figure 4-10). This GUI makes use of the 
PICkit Serial Analyzer in Master I2C mode. The controller board is configured to 
function as an I2C slave node. 

FIGURE 4-10: THE GUI WINDOW

If the connection to the controller board is correct, then the message box in the middle 
will read (Figure 4-11):

FIGURE 4-11: MESSAGE BOX READING

Note: The I2C Graphical User Interface requires the Microsoft® .NET Framework 
Version 2.0
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The GUI interface gives the user the following options to interact with the controller 
board:

- Reset the PICkit Serial (to reset communications)

- Receiver Test: for testing communications

- Clear Message: Clears message box

- Individual Read Request and Continuous Read (every 300 ms)

- Receiver Commands: Erase and Learn Transmitter

- LED control

4.26 RESETTING THE PICkit™ SERIAL

Press the RESET PKSA button to establish communications to the PICkit Serial 
Analyzer either at start-up or when a communications problem has arised.

4.27 COMMUNICATIONS TEST

This command sends predefined data to the controller board. This data is displayed on 
the controller LCD as:

Test Buffer

01234567
Use this command to verify the integrity of the communication.

4.28 ERASING AND LEARNING TRANSMITTERS

To erase all transmitters learned by the Controller board click the ERASE ALL check 
box, then click on the Transmit button. A message on the text box will display if the 
erase command was successful.

To Learn a transmitter, click the LEARN TRANSMITTER check box, then click on the 
Transmit button. A message on the text box will display if the learn command was 
successful.

4.29 RECEIVING DATA

Two receiving modes are available: on demand and continuous.

When clicking on the Read Request button, a single read command is sent through to 
the controller board. The controller will send the decoded information of the last trans-
mission received.

Checking the Continuous Read box will send a read request to the controller board 
every 300 ms. The information on the current last transmission is sent to the GUI at this 
rate.

FIGURE 4-12: SERIAL NUMBER AND DECRYPTED INFORMATION DISPLAY
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4.30 LED COMMANDS

Checking the desired LED boxes and pressing the Transmit button will turn on or off 
the requested LEDs.

4.31  I2C™ COMMUNICATIONS – SUMMARY OF COMMANDS 

All PICkit Serial communications with the controller board are done using the PICkit 
Serial as a master node, using the I2C communication protocol.

This is the set of I2C specific commands used to communicate with the controller board.

01  Test I2C Buffer 
This command sends a string of characters to the controller for display on the 
LCD. The characters are transmitted in 4 bytes of data.  When the GUI “Receiver 
Test” is pressed, the LCD on the controller board should read “Test Buffer 
01234567”. 

02  LED ON/OFF 
This is the command to turn the LEDs on or off.  The lower nibble of the byte 
received after the command indicates which LEDs turn on or off. Pressing the 
transmit button on the GUI without checking any LED boxes will turn off the LEDs.

03 TX buffer for transponder application (not implemented in this 
revision).

04 Receiver command
The next byte following the receiver command indicates a specific receiver 
activity: 
01 (Learn Transmitter) tells the controller to enter Learn mode 
02 (Erase Transmitters) tells the controller to erase all previously learned 
transmitters. 

For more information on I2C and KEELOQ decoding application, please refer to the 
application note AN1248, “PIC® MCU-Based KEELOQ Receiver System Interfaced via 
I2C”.
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Chapter 5.  KEELOQ® 3 Development Kit Controller
5.32 INTRODUCTION 

This chapter describes the basic user hardware interaction with the controller board.

5.33 HIGHLIGHTS 

This chapter discusses:

• PICkit™ Serial connection

• PICkit Programmer connection

• Receiver Board Selection Jumper

• LCD Display

• Radio Receiver

• Main Processor

• Prototyping Area

• Power Supply

5.34 PICkit SERIAL PIN ASSIGNMENTS 

The PICkit Serial connection header is designed to allow a PICkit serial to be con-
nected to the controller board. The communication is done using the I2C™ standard, in 
which case the PICkit Serial Analyzer is the master device and the board acts as a 
slave I2C device.

The pin assignments are shown in Figure 5-13.

FIGURE 5-13: PIN ASSIGNMENTS

1
2
3
4
5
6

Note: The 6-pin header (0.100" spacing) accepts 0.025" square pins.

 
I2C�

1 �
2 +V
3 GND
4 SDA
5 SCL
6 �

Pin 1 Indicator
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5.35 PICkit PIN ASSIGNMENTS 

The PICkit connection header allows a PICkit microcontroller programmer to be con-
nected directly to the controller to allow programming and/or debugging of the control-
ler. Other programmer/debuggers can be connected, though an RJ-11 to ICSP adapter 
might be necessary.

The pin assignments are shown in Figure 5-14.

FIGURE 5-14: PICkit™ PIN ASSIGNMENTS

5.36 LEARNING A TRANSMITTER TO THE CONTROLLER 

In order for the system to respond to incoming radio transmission from one of the 
KEELOQ transmitters, the controller must have information about the respective trans-
mitters. Such information includes the serial number and the synchronization counter.

In order to learn a new transmitter:

• Press the PB3 button on the controller. As a confirmation, the D4 LED will turn on.  

• Press one button on the transmitter. If the transmitter is correctly programmed, the 
D4 LED will begin blinking.

• Press again any button on the transmitter. If the learning process was successful, 
the D4 LED will turn off.

• As of now, the controller will be able to respond to the learned transmitter. This is 
confirmed by the D1-D4 LEDs corresponding to the four buttons on the remote 
control.

Pin Description*

1 = VPP/MCLR

2 = VDD Target

3 = VSS (ground)

4 = ICSPDAT/PGD

5 = ICSPCLK/PGC

6 = Auxiliary

*  The 6-pin header (0.100" spacing) accepts 0.025" square pins.
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5.37 RECEIVER BOARD SELECTOR PIN 

The controller board contains an ASK radio receiver module. The pinout corresponds 
to the standard PICtail™ connector. Thus, it may be easily replaced with similar models 
accommodating other frequencies, modulation methods (ASK vs. FSK) as well as 
adapting transponder boards for two-way communication.

On the controller board there is a jumper (J5) that allows for receiver card selection. 
The KEELOQ 3 Development Kit is supplied with the ASK receiver board. Optionally, an 
FSK transceiver card is available. The jumper configuration is:

• ASK receiver board: pins 1 and 2 connected, jumper to the left side

• FSK board: pins 2 and 3 connected, jumper to the right side.

• J5 also allows the radio receiver output to be disconnected from the main 
processor. This permits monitoring the receiver output on an oscilloscope or 
injecting an encoder’s digital output directly into the decoder.

5.38 PICtail™ CONNECTOR 

The board features two connectors. One 14 pin is dedicated for the receiver modules. 
While the connector has 14 pins, not all the pins are used. The ASK receiver board only 
uses the following pins:

• Pin 11 – RF data out  

• Pin 13 – VDD 5V

• Pin 14 – GND

The board also features a 28-pin connector that provides an easy access to all of the 
PIC16F886 pins.

5.39 LCD DISPLAY

A 2-line by 16 characters LCD display is present on the board. It is used to display. 
When the controller receives a KEELOQ transmission, the serial code and the decrypted 
data will be shown on the display. The LCD contrast can be adjusted by the contrast 
pot located on the bottom side of the controller board, near push button PB1.

5.40 MAIN PROCESSOR

The main processor contains a SOIC PIC16F886 operating at 8 MHz. The 
microcontroller provides connections for the LCD display, programming, push buttons, 
LEDs and RF board control. Please refer to the schematic in Appendix A. “KeeLoq® 
3 Development Kit Schematics” for further information.

5.41 POWER SUPPLY AND PROTOTYPING AREA

The power supply circuit is designed to regulate a maximum current of 100 mA at 5V 
from an external 9V power supply. 

The prototyping area includes convenient VDD. and GND through hole strips to power 
custom circuitry. The user must ensure that the Prototype area custom circuit current 
draw added to the controller board consumption does not exceed the 100 mA total limit.
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NOTES:
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Chapter 6.  KEELOQ® 3 Development Kit Controller Firmware
6.42 INTRODUCTION

The controller is the heart of the KEELOQ® 3 Development kit. It is the receiving side of 
the KEELOQ system. In order for the system to respond to incoming radio transmission 
from one of the KEELOQ transmitters, the controller must have information about the 
respective transmitters. 

Such information includes the serial number and the synchronization counter. Both are 
very important pieces of information and present the root of the KEELOQ decoding. The 
learning procedure is explained in Section 5.36 “Learning a Transmitter to the 
Controller ”. 

6.43 HIGHLIGHTS 

This chapter discusses:

• Overview of the firmware running on the controller

• Data packet receiving

• KEELOQ Decryption 

• I2C™ communication

6.44 KEELOQ DATA PACKET RECEIVING  

The data packet section of the controller firmware receives and decodes PWM 
modulated KEELOQ transmissions. This routine only checks for and decodes KEELOQ 
transmissions coming from the radio receiver module. 

PWM Format

In general, all KEELOQ encoders share a common transmission format:

• A preamble to improve biasing of decision thresholds in super-regenerative 
receivers. The preamble consists of alternate on and off periods, each lasting as 
long as a single elemental period.

• A calibration header consisting of a low period of 10 elemental periods. 
Calibration actions should be performed on the low period of the header to ensure 
correct operation with header chopping.

• A string of pulse-width modulated bits, each consisting of three elements. The first 
element is high, the second contains the data transmitted and is either high or low, 
and the third element is always low.

• A guard period is usually left between the transmissions. During this period 
nothing is transmitted by the encoder.
 2011 Microchip Technology Inc.  DS41378B-page 37



KEELOQ® 3 Development Kit User’s Guide
FIGURE 6-15: KEELOQ® PWM TRANSMISSION FORMAT

6.45 KEELOQ DECRYPTING 

The controller will automatically decrypt and display information on any incoming 
traditional KEELOQ, AES or XTEA radio packet received by the radio receiver module. 
The validity of the data will be dependent on the encryption keys used to encode the 
information on the transmitter.

Decryption is done using the normal key generation algorithm based on the controller 
manufacturer code. The source code is available on the KEELOQ 3 Development Kit 
CD-ROM.

6.46 I2C COMMUNICATION 

The I2C connection header allows a PICkit Serial Analyzer module to be connected to 
the controller board. The controller supports a set of commands that allows the 
controller to function as a truly I2C KEELOQ decoder. The I2C master device (the PICkit 
Serial Analyzer in this case) can instruct the controller to learn and delete transmitters, 
and to read transmission. Some debug commands are also present (e.g., LED test), 
see Section 4.31 “I2C™ Communications – Summary of Commands ”.

6.47 LCD DISPLAY

The LCD will display the serial number and the encrypted section (already decrypted) 
of the last received transmission. When a new transmission is received, the display is 
automatically updated. 
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Chapter 7.  KEELOQ® 3 Development Kit PIC16F636 Transmitter
7.48 INTRODUCTION 

The KEELOQ® 3 Development Kit PIC16F636 transmitter is a SAW-based, short range, 
low-cost OOK (on-off keying) transmitter. The KEELOQ encoding is done on the 
PIC16F636 microcontroller. The PIC16F636 features an internal KEELOQ encryption 
peripheral, which eases encoding code development. All encoder data is stored in the 
PIC16F636 internal EEPROM.

7.49 HIGHLIGHTS 

This chapter discusses:

• Main features of the PIC16F636 transmitter

• KEELOQ software encoder source code

7.50 MAIN FEATURES

The PIC16F636 transmitter is a software-based device. The KEELOQ encoder source 
code is available under the KEELOQ encoder license. Thus, the user has complete 
freedom in designing their own custom solution. While the kit comes with specific 
software, there is basically no limitation in modifying the source code to create custom 
encoding schemes.

In addition, the PIC16F636 based transmitter can support an 8 or 14-pin socket for use 
with code development with other PIC® devices. The four buttons (S0... S3) on the 
transmitter are connected to input pins on the microcontroller. The user may activate 
any combination of buttons transmitting any of the 15 possible function codes.

Header J2 (unpopulated) can be used for further development or for additional function 
codes for XTEA and AES encoding protocols.

The battery holder accepts one CR2032 3V lithium battery, positive side up. The RF 
oscillator circuit is designed to operate at this voltage.

Some of the features of the software-based PIC16F636 KEELOQ encoder are:

• Two programmable 32-bit serial numbers

• Two programmable 64-bit crypt keys

• Two programmable 60-bit seed values

• Four button inputs

• Four selectable baud rates

• PWM, VPWM, PPM and Manchester modulation

The included CD also contains software for a KEELOQ/XTEA and KEELOQ/AES 
encoder, which include a larger serial number and crypt keys. All other functionality 
remains the same.
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7.51 PICkit™ PIN ASSIGNMENTS

The 6-pin header is compatible with the PICkit microcontroller programmer and allows 
direct connection to it. The pin assignment is:

7.52 PROGRAMMING THE TRANSMITTER 

Programming the transmitter can be done using the PICkit microcontroller programmer 
along with the supplied software. The MPLAB KEELOQ plug-in allows full configuration 
and programming of the transmitter.

7.53 TRANSMITTER FIRMWARE

The PIC16F636 transmitter is based on a KEELOQ encoder firmware and thus, it is a 
software encoder. The source code is available on the KEELOQ 3 Development Kit 
CD-ROM.

TABLE 7-4: PICkit™ PIN ASSIGNMENTS
1  MCLR/VPP

2 VDD

3 GND

4 ICSPDAT

5 ICSPCLK

6 NC
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Chapter 8.  KEELOQ® Transceiver Add-On Kit
8.54 INTRODUCTION 

The KEELOQ® Transceiver Add-On kit consists of the following components:

- A Receiver/Transceiver board. This board is intended to be mounted on the 
KEELOQ 3 controller board.

- A Transceiver key fob. It has many functionalities of the regular key fob in 
addition to receiving data packets from the controller board and from other 
Transceiver key fobs.

8.55 CHARACTERISTICS

• Both boards use the MRF49XA RF Transceiver. For more information on how to 
program and use the MRF49XA, please read application note AN1252, “Interfac-
ing the MRF49XA Transceiver to PIC® Microcontrollers”.

• Transmission mode and Frequency: FSK, 915 MHz.

• Data transferred via SPI between the transceiver IC and the microcontroller.

• Ideal for authentication, passive entry, status acknowledge applications.

8.56 RECEIVER BOARD

The receiver board contains the transceiver device and is designed to receive and 
transmit on the 915 MHz ISM band. This module design is suitable for wireless remote 
command and control, Remote Keyless Entry, security systems and similar applica-
tions where two-way security or acknowledge is needed. 

The Add-On Kit Receiver module was designed to be compatible with the PICtail™ 
connector so it can be used and installed in any project with a PICtail header.

The following configuration is used on the receiver board:

• Single Channel 915.000 MHz Frequency (135 kHz BW)

• FSK modulation 

• Signal Rate: 9579 Baud

• SPI communication with microcontroller
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FIGURE 8-16: RECEIVER BOARD

Table 8-5 lists the pin out for the Add-On Kit Receiver Board.

8.57 TRANSCEIVER KEY FOB

The transceiver key fob is a PIC16F636 microcontroller software encoder/decoder with 
a MRF49XA transceiver. This key fob is designed to communicate with the receiver 
board as well as other key fobs.

TABLE 8-5:

Pin Description

1 FFIT: FIFO interrupt

2 SDI: SPI Data In

3 NC

4 nFFS:FIFO select

5 SEL: Chip Select

6 SDO: SPI Data Out

7 NC

8 SCK: SPI Clock

9 IRQ:Interrupt request

10 ARSSI: Received signal strength indicator

11 NC

12 NC

13 Power: 3-5V

14 Ground

MRF49XA

PIN 1
DS41378B-page 42   2011 Microchip Technology Inc.



KEELOQ® Transceiver Add-On Kit
FIGURE 8-17: RECEIVER BOARD

8.58 HARDWARE SETUP

Plug the receiver board into the PICtail 14 connector, as shown in Figure 8-18

FIGURE 8-18: PICtail™ 14 CONNECTOR

MRF49XA

PIC16F636

Battery
Holder

PICkit™ Programmer
Connector
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Program the file AN1239_Base_Keeloq_Add_On.hex onto the receiver board. The 
file is located in \Program Files\Microchip\KEELOQ Decryption Software\AN1329 PIC 
MCU KEELOQ Receiver System with Acknowledge\Source Code.

To program the control board using the MPLAB® IDE, select File->Import, and then pro-
gram with the programmer of your choice.

8.59 USING THE TRANSCEIVER KEY FOB

Insert a CR2032 or equivalent battery into the battery holder of the key fob transmitter.

8.60 HOW TO LEARN A TRANSMITTER

- Press button 0 on the key fob. The LEDs D1 and D2 will flash twice.

- Press PB1 on the base station. The LCD will display:

 Learn Phase 1…

- Press button 0 on the key fob transceiver twice. Base station LED D2 will 
flash momentarily and the LCD will display:

System Unlocked

- Transceiver LED D2 will flash, indicating that the base station has acknowl-
edged the transmission. 

- Press button 1 on the key fob transceiver. Base station LED D2 will flash 
momentarily and the LCD will display:

System Locked

- Immediately afterward, transceiver LED D1 will flash, indicating that the base 
station has acknowledged the transmission 

- Press button 2 on the key fob transceiver. Base station LED D2 will flash 
momentarily and the LCD will display:

Status Request

- Note that button 3 on the key fob does not cause a transmission. This button 
echoes the last acknowledge message received.

8.61 USING THE MPLAB PLUG-IN

Refer to Chapter 3. “Using the KEELOQ® 3 Development Kit MPLAB Plug-In” for 
instructions on how to install and open the KEELOQ 3 Development Kit MPLAB Plug-In.

8.62 PROGRAMMING THE PIC16F636 KEY FOB TRANSCEIVER

This transceiver allows the firmware to be adapted for any particular need.The key fob 
transceiver source codes for KEELOQ, AES and XTEA encryption are provided by 
Microchip under the KEELOQ encoder license agreement.

All the encoder configuration data, encryption keys, seeds and serial numbers are 
stored into the EEPROM of the PIC16F636.

The MPLAB KEELOQ plug-in cannot directly program the microcontroller. Instead, the 
KEELOQ software encoder source code must be loaded into MPLAB.The plug-in can 
export the memory map for the current encoder options to the EEPROM memory.
DS41378B-page 44   2011 Microchip Technology Inc.



KEELOQ® Transceiver Add-On Kit
FIGURE 8-19: SOFTWARE TRANSCEIVERS

8.63 UPGRADE TO ADVANCE ENCRYPTION 

AES and XTEA advanced encryption versions of the decoder and encoder firmware 
are available from Microchip through microchipDIRECT. Please order the “KEELOQ 
Advanced Security Algorithms CD”.

TABLE 8-6: PROGRAMMING CONFIGURATION OPTIONS

Configuration Option Description

Key Generation Selects the encryption algorithm

Serial Number Enter a 32-bit hex value

Sync Counter The starting point of the sync counter

User Value You can opt for the default setting equal to the 10 LSbs of the serial number or enter an 
arbitrary (User) value

Timeout If enabled, the device will shut off after transmitting continuously for a predetermined time

Max Retry Number of times to send transmission packet

Dual Encoder Enable Makes button 3 act as a SHIFT input to select between encoder #1 and #2 activation
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Chapter 9.  Troubleshooting
9.64 INTRODUCTION 

Here you should find the needed information in case anything does not work as it 
should.

9.65 FREQUENTLY ASKED QUESTIONS 

Q: The controller cannot learn a transmitter.

A: Most likely the transmitter is not programmed correctly.

Q: Can an HCS device be programmed while MPLAB® IDE already has a loaded 
project?

A: Yes, provided that the programmer hardware is only selected for the KEELOQ plug-in 
and the MPLAB main software uses another programmer (or none).

Q: Is the KEELOQ plug-in able to program a PIC16F636 with encoder firmware?

A: No, you need to load the source code project first. For the PIC16F636, the KEELOQ 
plug-in can only export EEPROM data.
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Appendix A. KEELOQ® 3 Development Kit Schematics
FIGURE A-1: LAYOUT OF THE KEELOQ EVALUATION KIT III CONTROLLER BOARD
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FIGURE A-2: RECEIVER BOARD
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FIGURE A-3: HCS362 HARDWARE ENCODER TRANSMITTER BOARD
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FIGURE A-4: PIC16F636 SOFTWARE ENCODER TRANSMITTER BOARD
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Appendix B. MRF49XA Schematics
FIGURE B-1: MRF49XA RECEIVER BOARD
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FIGURE B-2: MRF49XA KEY FOB TRANSCEIVER
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